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Introduction
This section provides you with an overview of ComicTrac, and a list of features the program 
supports.

Using ComicTrac Help
This section provides you with instructions on how to use the ComicTrac help system.

Using ComicTrac
This section provides you with step-by-step instructions on using ComicTrac.

ComicTrac Window Descriptions
This section provides you with descriptions of the windows ComicTrac uses.

ComicTrac Tips and Tricks
This section provides you with tips and tricks which can make using ComicTrac easier.

Credits and Technical Support
This section provides you with technical support information.



Introduction
Overview:
Welcome to ComicTrac, a new and exciting product from StormWarden Enterprises. 
ComicTrac allows you to enter your entire comic collection into an easy to use and maintain
database. A must for comic collectors, ComicTrac is perfect for small and large comic 
collections, replacing hard to maintain paper records. Once your place your information in 
ComicTrac, you can:

Search for specific comics or range of comics.
Print or display reports which give you information about your comic collection.
Continue to add comics, delete comics, change comics, and otherwise maintain your 

comic collection with ease.

ComicTrac features include:
ComicTrac's Find window which allows you to enter any combination of information to

quickly access the comics you want to see.
ComicTrac's Summary window which allows you to view the results of the Find 

window's actions, giving you a quick summary of information. You can then choose comics 
for which you want to view detailed information.

ComicTrac's Comic window which displays detailed information about comics you 
choose on the Summary window. This window also allows you to add, delete, and change 
comics.

ComicTrac's Report window which allows you to choose one of several different 
reports which give you information about your entire collection. You can view the report on 
your computer screen, or print it to a Windows supported printer.

ComicTrac's Help system which provides you with quick answers to any questions you
may have about ComicTrac.
 



Jump to the Same Window - Example
This topic displays in the same window where you clicked the green, underlined text.

To return to the previous topic:
1. Click . The previous topic displays in the window.



Jump to Another Window - Example
This topic displays in a new window next to the window where you clicked the green, 
underlined text. 

To return to the previous topic:
1. Click  to close this window.



Popup Example
This shows an example of a popup.

To close a popup:
1. Click anywhere on the screen.



Hot Spotted Pictures - Example
The picture you clicked performed a popup. Hot spotted pictures usually perform popups, 
but can sometimes perform jumps.



Using ComicTrac Help
This topic gives a general description of how to use the ComicTrac help system. If you do 
not know how to use a standard Windows help system already, select the How to Use 
Help option from the Help menu to view Microsoft's help file on using Windows help.

The ComicTrac help system supports all standard Windows help functions. A quick review of
standard help functions follows:
Context Sensitive Help
Context senstive help gives you help on any field on the window. To access this help:
1. Click in the field for which you want information.
2. Press F1. A popup appears with help on the field.
3. Click the mouse to close the popup.

Help Button on the Toolbar
Click this button to get help on the currently open window. If no window is open, this 

brings up the main contents page.

Jumps
Jumps take you to another place in the help. ComicTrac Help highlights a jump as green, 
underlined text. A jump can do two things in ComicTrac Help.
1. Jump you to a topic in the same window. Click here to seen an example of a jump to the 

same window.
2. Jump to a topic in another window. Click here to see an example of a jump to another 

window.

Popups
Popups display a small window with brief information, usually about a glossary term, or a 
field on the window. ComicTrac Help highlights a popup as green, dotted underlined text. 
Click here to see an example of a popup.

Hot Spotted Pictures
Hot spotted pictures are pictures which do something when you click on them. You can tell 
a picture has a hot spot when you move the mouse cursor over it. If the picture has a hot 
spot, the mouse pointer arrow changes to a hand. Click the left mouse button to activate 
the hotspot. Click the picture to see an example of a hot spot --> .

Browse Buttons
The  (browse buttons) are located at the top of the main Help window. 
When ComicTrac Help has a browse sequence associated with a topic, one or both of the 
browse buttons activate. Click the buttons to browse through related topics.

You have now read about standard help features which ComicTrac supports. If you need 
more information, please read Microsoft's help file on using Windows help.



Using ComicTrac
ComicTrac uses a simple, intuitive interface which enables you to maintain you comic 
collection with ease. The following topics describe how to use the interface to maintain 
your collection.

Viewing Comic Information
This topic describes how to search for and view information in your comic collection.

Adding Comics
This topic describes how to add comics to your collection.

Changing Comics
This topic describes how to change information for comics you previously entered.

Deleting Comics
This topic describes how to delete comics from your collection.

Printing Reports
This topic describes how to print the different reports.

Backing Up and Repairing the Database
This topic describes how to repair and backup the ComicTrac database.



Viewing Comic Information
This topic describes how to find and view information from your comic collection. The only 
limit to the number of ways to search for information is how thorough you were when you 
entered your comics. The more information you put into ComicTrac, the more useful 
ComicTrac is.

Viewing comic information contains three steps:
1. Searching for the comic or range of comics.
2. Viewing a summary of the results of search on the Summary window.
3. Viewing the specific comics on the Comic Information window.

Finding Comics
Use ComicTrac's Find window to search for information. You can enter information in each 
field on the window. The more information you enter, the more specific the search. If you 
leave the Find window blank, ComicTrac finds all comics in the collection.

To find a comic or range of comics:

1. Click . The Find window appears.
2. Enter information into the fields on the window. The Find window uses the information
you type as a wildcard. For example, typing the letter "a" in the Series field finds all series 
which begin with "a".

Once you enter all the information, you must view the results on the Summary window.

Viewing the Results
Once you fill in your information on the Find window, you view the results on the Summary 
window.

To access the Summary window:

1. Click . The Summary window displays.

The Summary window displays the results of your search in a table. If you want to view 
more detailed information about the comics on the Summary window, you must view them 
on the Comic Information window.

Getting Detailed Information
Use the Comic Information window to view detailed information about the comics your 
search found.

To view more detailed information:
1. Move the mouse pointer to the left side of the Summary window until it is over the row 

you want to view more information for. The mousepointer changes to a checkmark.
2. Click the row you want to view more information for. This highlights the row.

Repeat steps 1 and 2 until you select all the rows for which you want to view more 
information.

Note: For instructions on using , see the Summary window description.

3. Click  once you select your rows. The Comic Information window displays.
4. Use  to move through the selected comics.





Adding Comics
This topic describes how to add comics using ComicTrac. When you enter comics into 
ComicTrac, you must enter as much information as possible to make full use of the 
database.

There are two ways to add comics in ComicTrac:
1. Add comics one at a time.
2. Use the Group Add option.

Adding Comics One at a Time
This is the simplest method to enter comics. It is also the most time consuming, so if you 
want to add several consecutive comics within the same series, see the "Adding Comics 
Using Group Add" section.
To add comics one at a time:
1. Click . The Comic Information window appears.

Note: If you are adding comics to an empty database, you must click . 
ComicTrac automatically takes you to the Comic Information window.

2. Click . ComicTrac puts the Comic Information window into Add mode.
3. Enter your information on the Comic Information window. See Entering Information in 
ComicTrac for different methods of entering information.

Note: You must have a valid Publisher, Series, Comic#, Condition, Value and 
Print# to successfully add a comic.

4. Click . ComicTrac informs you if the save was successful. If there was an error, fix
the information and repeat step 4.

Adding Comics Using Group Add
Use the Group Add option to add consecutive groups of comics. For example, if you have 
the first 10 comics of a series, and you know they have the same condition and value, you 
can use Group Add to add all 10 at once.
To use the Group Add:
1. Follow the first three steps of the above "Adding Comics One at a Time" section.

2. Click . The Group Add window appears.
3. Enter the number range of the comics you wish to enter. For example, 1 to 10.
4. Click  to begin the group add. The blue status bar shows you the progress.
If a comic in your number range already exists in the database, ComicTrac gives you the 
option of overwriting the comic. Click  to overwrite the previous comic.

 Once overwritten, there is no way to get the old information back.
Each comic in the Group Add contains the same Publisher, Series, Comic#, Condition, 
Value, Print#, Writer, Pencils/Inks, and Colorist. After you add a group, you should go 
back and edit the comics to add or change any of the information.



Changing Comics
This topic describes how to change information already entered in the database. For 
example, when the value of a comic changes, you need to go into ComicTrac to change it to
the new value.

To change a comic:
1. View the comic you want to change on the Comic Information window. See Viewing 

Comic Information for step-by-step instructions on viewing comics.

2. Click . The ComicTrac Information window enters change mode.
3. Enter information in the fields you want to change. See Entering Information in 
ComicTrac for instructions on entering information.

Note: When you edit a comic, you cannot change the Publisher, Series or 
Comic#. If these are incorrect, you must delete the comic and re-add the comic.

4. Click  to save the changed comic. A message appears telling you the changes
were successful. If there are any errors, repeat steps 3 to 4.



Deleting Comics
This topic describes how to delete comics using ComicTrac. Once you delete a comic, you 
cannot recover it unless you have a backup of the database.

To delete a comic:
1. View the comic you want to delete on the Comic Information window. See Viewing Comic 

Information for step-by-step instructions on viewing comics.

2. Click . ComicTrac checks to ensure you want to delete the comic, then deletes it 
from the database.

If you deleted a comic you need back, either copy your backup of the database over the 
original, or re-add the comic.



Printing Reports
This topic describes how to print the ComicTrac reports. Reports give you up to date 
information on your comic collection.

ComicTrac Report Definitions
There are three different reports you can use to get information about your comic 
collection.
1. Collection Total - This report prints the total value of your collection, broken down by 

Publisher and Series. This report is only as accurate as the information you enter into the 
database.

2. Top Ten Comics - This report prints the top ten comics by value in your collection.
3. Need and Replace List - This report prints the comics you need for your collection. This

includes any gaps numerically in your collection as well as any comics which are below a 
condition you specify. For example, you may want to get a report on any comics in your 
collection whose condition is less than "FN".
Note: If the first comic number you enter for a series is "300", then Need and 

Replace does not indicate you need "1 to 299". ComicTrac finds gaps. If you have 
comic "1" and then "300", ComicTrac indicates you need "2 to 299".

Printing ComicTrac Reports
You can print any one of the reports either to a window, or to any Windows printer.
To print a report:
1. Select the Print option from the File menu.
2. Click which report you want to print.
3. If you are printing the Needs List report, you can enter information in the bottom half of 

the window to specify Publisher, Series and Conditions. See the Print Report Window 
Description for more information.

4. Click Window or Printer to indicate where you want ComicTrac to print the information.

5. If you want to print to a printer, click  to ensure your printer is setup 
correctly.

6. Click  to print the information.

If you print to a window:
Use 

 at the bottom of the window to scroll through the pages.

If you print to the printer:
You can click 

 at any time to cancel the printing.



Backing Up and Repairing the Database
This topic describes how to backup and repair your ComicTrac database. The database file 
ends with a ".mdb" extension, and is located in the "data" directory of your ComicTrac 
directory.

Repairing the Database
There is a possibility that your ComicTrac database can become corrupted. If this happens, 
you need to repair the database.
To repair the database:
1. Ensure both the Comic Information window and Summary window are closed.
2. Select Repair Database from the Tools menu. ComicTrac attempts to repair the 

database.
3. If the repair fails, you must restore a backup of the database.

Backing up the Database
You should back up the database at least once a month, to ensure that if something 
happens to the database,    you do not lose your information. When ComicTrac backs up the 
database, it also compacts it to save hard drive space.
To backup the database:
1. Ensure both the Comic Information window and Summary window are closed.
2. Select Backup Database from the Tools menu. ComicTrac backs up the database.
ComicTrac names your old database "COMBAK.MDB" and places it in the same directory as 
your other data files.

Restoring a Backup of the Database
If a repair fails, or you accidentally erase your main database file, you have to restore a 
previously made backup.
To restore the backup:
1. Exit ComicTrac.
2. Enter your Windows File Manager.
3. Rename the "COMBAK.MDB" file in your data directory as "COMTRAC.MDB".
4. Run ComicTrac.



ComicTrac Window Descriptions
This topic gives you a high level description of the ComicTrac windows.

Find Window
You use this window to enter information which ComicTrac can use to search the database. 
For example, if you need to find all comics which have the word "mutants" in the title, you 
can enter this information and view the results on the summary window.

Click here to view more information about the Find window.

Summary Window
You use this window to view the results the Find window returns. ComicTrac displays the 
results on the Summary window in a table.    You can click rows on the Summary window 
and view more information about the rows on the Comic Information window.

Click here to view more information about the Summary window.

Comic Information Window
You use this window to view detailed information on rows you selected on the Summary 
window. You also use this window to add, change and delete comics.

Click here to view more information about the Comic Information window.
 
Print Reports Window
You use this window to print ComicTrac's custom reports. You can print reports to a window 
or to your printer. For some reports, you can specify a Publisher, Series, and Condition 
to limit the comics printed.

Click here to view more information about the Print Reports window.



Find Window Description
Use this window to search for comics in the ComicTrac database. The more information you 
put on the Find window, the more narrow the search.

Using the Find Window
To access the Find window:
1. Click . The Find window appears.

To use the Find window:
1. Enter information on the Find window. See Entering Information in ComicTrac for 

instructions on entering information on windows.
2. Click  to access the Summary window.

The Find Window Contains the Following:
Main Information:
Publisher
Series
Comic#

Additional Find Information:
Story
Pencils/Inks
Colorist
First Appearance
First Appearance (Full)
Appearance By
Death Of
Comments



Publisher
This shows the name of the publisher for which you want to search.
To enter a publisher:
1. Click . A list of the publishers in the ComicTrac database appears.

2. Click the publisher name you want to search for.
For example, click "Marvel" to select Marvel comics as the publisher.



Series
This shows the name of the series for which you want to search.
To enter a series:
1. Click . A list of the series in the ComicTrac database appears.

2. Click the series name you want to search for.
For example, click "ComicTrac Guy" to select ComicTrac Guy as the comic series for which 
you want to search.



Comic#
This shows the comic number for which you want to search.
To enter a comic number:
1. Click in the Comic# box.
2. Type the number for which you want to search.
For example, if you want to find all number "1"'s in your collection, enter the number "1".



Story
This shows the name of the writer of the story for which you want to search.
To enter the writer information:
1. Click in the Story box.
2. Type the name or part of a name for which you want to search.
If you want to find all comics where Marv Wolfman wrote the story, type "Wolfman" in the 
box.



Pencils/Inks
This shows the names of the penciller and inker for the comics you want to search for.
To enter the pencils/inks information:
1. Click in the Pencils/Inks box.
2. Type the name or part of a name for which you want to search.



Colorist
This shows the name of the colorist for the comics you want to search for.
To enter the colorist information:
1. Click in the Colorist box.
2. Type the name or part of a name for which you want to search.



First Appearance
This shows the name of a character who had a first appearance in the comics you want to 
search for.
To enter the first appearance information:
1. Click in the First Appearance box.
2. Type the name or part of a name for which you want to search.



First Appearance (Full)
This shows the name of a character who had a first full appearance in the comics you want 
to search for.
To enter the first full appearance information:
1. Click in the First Appearance (Full) box.
2. Type the name or part of a name for which you want to search.



Appearance By
This shows the name of a character who had an appearance in the comics you want to 
search for.
To enter the appearance information:
1. Click in the Appearance By box.
2. Type the name or part of a name for which you want to search.



Death Of
This shows the name of a character who died in the comics you want to search for.
To enter the death of information:
1. Click in the Death Of box.
2. Type the name or part of a name for which you want to search.



Comments
This shows any miscellaneous comic information you want to search for.
To enter the comments information:
1. Click in the Comments box.
2. Type the information for which you want to search.



Summary Window Description
Use this window to view summary information of the comics you searched for with the Find 
window. You can select comics on this window and view more detailed information on the 
Comic Information window.

Using the Summary Window
To access the Summary window:
1. Click . The Summary window appears.

To use the Summary window:
1. Select the comics for which you want more information. See the Getting Detailed 

Information section in the Viewing Comic Information topic for step-by-step instructions 
on selecting comics.

2. Click  to access the Comic Information window.

The Summary Window Contains the Following:
Publisher
Series
Comic#
Box
Type

Click 
 to select all comics on the Summary window.

Click 
 to select all comics which are between two other selected comics.

Click 
 to remove selection from all comics on the Summary window.



Publisher
This shows the name of the publisher for the comic in the current row. For example, if 
"Marvel" is in the column, this indicates "Marvel" is the publisher for the comic.



Series
This shows the name of the series for the comic in the current row.



Comic#
This shows the number of the comic in the current row.



Box
This shows the name or number of the box which contains the comic in the current row.



Type
This shows the type of comic which is in the current row. The types are as follows:

Regular - indicates regular series.
Annual - indicates an annual comic.
Special - indicates a special issue.
Other - indicates a comic which does not fall under the above three.



Comic Information Window Description
Use this window to view detailed information for comics, as well as add, change and delete 
comics in the database.

Using the Comic Information Window
To access the Comic Information window:
1. Click . The Comic Information window appears.

To use the Comic Information window to view detailed information:
1. Select comics you want to view on the Summary window.
2. Click     to access the Comic Information window. See Viewing Comic 

Information for step-by-step instructions on viewing comics.

To use the Comic Information window to add comics:
1. Click . The Comic Information window sets up for the add. See Adding Comics 

in ComicTrac for step-by-step instructions on adding comics.

To use the Comic Information window to change comics:
1. Click . The Comic Information window sets up to change comics. See 

Changing Comics in ComicTrac for step-by-step instructions on changing comics.

To use the Comic Information window to delete comics:
1. Click . ComicTrac deletes the currently selected comic. See Deleting Comics 

in ComicTrac for more information on deleting comics.

The Comic Information Window Contains the Following:
Series Information:
Publisher
Series
Comic#

Comic Information:
Box
Date Published
Comic Information Table
Date Updated

Click 
 to move to another comic.

Miscellaneous Information:
Story
Pencils/Inks
Colorist
First Appearance
First Appearance (Full)
Appearance By
Death Of

Comments:
Comments



Regular
Annual
Special
Other



Publisher
This shows the name of the publisher for the displayed comic.
To enter a publisher when adding a comic:
1. Click . A list of the publishers in the ComicTrac database appears.

2. Click the publisher name you want to add a comic for.
OR

1. Type in the name of a new publisher.



Series
This shows the name of the series for the displayed comic.
To enter a series when you are adding a comic:
1. Click . A list of the series in the ComicTrac database appears.

2. Click the series name for which you want to add a comic.
OR

1. Type in the name of a new series.



Comic#
This shows the number of the displayed comic.
To enter a comic number when adding a comic:
1. Click in the Comic# box.
2. Type the number of the new comic.



Box
This shows the name or number of the box which contains the currently displayed comic.
To enter box information when adding or changing a comic:
1. Click in the Box field.
2. Enter the information.



Date Published
This shows the date the currently displayed comic was published.
To enter the date published when adding or changing a comic:
1. Click  to access a list of the months.

2. Select the month in which the comic was published.
3. Click in the box next to the month selector.
4. Type in the year the comic was published.



Comic Information Table
This table shows the information used to calculate the comic's value. Each row of the table 
is a different comic. For example, if you have 5 copies of ComicTrac Guy #1, but two of the 
copies are second printing, the information could appear as follows:

The Comic Information Table is in the center of the Comic Information Window.

The table contains the following columns:
Cond
Print#
Value
Copies
Total



Cond
This column shows the condition of the comic for the current row. The conditions are as 
follows:

MT - Mint
NM - Near Mint
VF - Very Fine
FN - Fine
VG - Very Good
GD - Good
FR - Fair
PR - Poor

To enter a condition when adding or changing a comic:
1. Click in the column
2. Select a condition from the drop down list.



Print#
This column shows the print number of the comic for the current row. Some comics are so 
popular they go through two or more printings. First prints are usually the most valuable.
To enter a value when adding or changing a comic:
1. Click in the column.
2. Type the print number.



Value
This column shows the value of the comic for the current row. Value depends upon the 
comic, print number and condition. Use an official comic book price guide to determine the 
value of your comics.
To enter a value when adding or changing a comic:
1. Click in the column.
2. Type the value.



Copies
This shows the number of copies of the comic for the current row. For example, you could 
have three near mint copies of the first printing of ComicTrac Guy number one.
To enter a value when adding or changing a comic:
1. Click in the column.
2. Type the number of copies.



Total
This column shows the total value for each row. For example, if you have three near mint 
copies of the first printing of ComicTrac Guy #1 which are valued at $10.00, then the total 
column will read $30.00. ComicTrac automatically calculates and keeps track of this total 
for you.



Date Updated
This shows the date when you last changed the currently displayed comic. ComicTrac 
automatically updates and keeps track of this date for you.



Story
This shows the name of the writer of the story for the currently displayed comic.
To enter the writer information when adding or changing a comic:
1. Click in the Story box.
2. Type the name of the writer for the comic.



Pencils/Inks
This shows the names of the penciller and inker for the currently displayed comic.
To enter the pencils/inks information when adding or changing a comic:
1. Click in the Pencils/Inks box.
2. Type the names of the penciller and inker.



Colorist
This shows the name of the colorist for the currently displayed comic.
To enter the colorist information if you are adding or changing a comic:
1. Click in the Colorist box.
2. Type the name of the colorist.



First Appearance
This shows the name of a character who had a first appearance in the currently displayed 
comic.
To enter the first appearance information if you are adding or changing a comic:
1. Click in the First Appearance box.
2. Type the name of the character which had a first appearance.



First Appearance (Full)
This shows the name of a character who had a first full appearance in the currently 
displayed comic.
To enter the first full appearance information if you are adding or changing a 
comic:
1. Click in the First Appearance (Full) box.
2. Type the name of the character which had a first full appearance.



Appearance By
This shows the name of a character who had an appearance in the currently displayed 
comic.
To enter the appearance information if you are adding or changing a comic:
1. Click in the Appearance By box.
2. Type the name of the character which appeared in the comic.



Death Of
This shows the name of a character who died in the currently displayed comic.
To enter the death of information if you are adding or changing a comic:
1. Click in the Death Of box.
2. Type the name of the character which died.



Comments
This shows any miscellaneous comic information for the currently displayed comic.
To enter the comments information if you are adding or changing a comic:
1. Click in the Comments box.
2. Type the information for the comic.



Regular
If selected, this indicates the currently displayed comic is part of the regular series.
To select this when adding a comic:
1. Click the Regular option.



Annual
If selected, this indicates the currently displayed comic is an annual issue for the series.
To select this when adding a comic:
1. Click the Annual option.



Special
If selected, this indicates the currently displayed comic is a special edition.
To select this when adding a comic:
1. Click the Special option.



Other
If selected, this indicates the currently displayed comic is something other than a Regular, 
Annual or Special comic.
To select this when adding a comic:
1. Click the Other option.



Print Report Window Description
Use this window to print ComicTrac's custom reports. The custom reports give you valuable 
information about your comic program.

Using the Print Report Window
To access the Print Report window:
1. Select Print from the File menu. The Print Report window appears.

To use the Print Report window:
1. Select the report you want to print. See Printing Reports in ComicTrac for instructions on 

selecting and printing reports.
2. Select either printing to a    window, or printing to a printer.
3. Click  to start printing.

The Print Window Contains the Following:
Reports Information:
Collection Total
Top Ten
Needs List

Description

Print Options:
Window
Printer

Report Options (Needs List Report Only):
Publisher
Series
Condition < Than

Click 
 to access the printer setup options.

Click 
 to begin printing.

Click 
 to cancel the print report and close the window.



Collection Total
This report prints the total value of your collection broken down by series.



Top Ten Report
This report prints the top ten value comics in your collection.



Needs List
This report prints which comics you need for your collection, as well as any you need to 
replace.



Description
This gives you a description of the currently selected report.



Window
Select this to print the report to the window.



Printer
Select this to print the report to you printer.



Publisher
This shows the name of the publisher for which you want to print the Needs List.
To enter a publisher:
1. Click . A list of the publishers in the ComicTrac database appears.

2. Click the publisher name you want to print.
For example, click "StormWarden" as the publisher for which you want to see gaps in your 
collection.



Series
This shows the name of the series for which you want to print the Needs List.
To enter a series:
1. Click . A list of the series in the ComicTrac database appears.

2. Click the series name you want to print for the Needs List.
For example, click "ComicTrac Guy" to select ComicTrac Guy as the comic series you want 
to print the needs list for.



Condition < Than
Use this to indicate which comic condition you want to include in the Needs List. For 
example, if you select VF as the condition, ComicTrac will print all comics which have a 
condition less than VF.
To select a condition:
1. Click  arrow. A list of conditions appears.

2. Click the condition for the Needs List.



Credits and Technical Support
This topic gives you information on how to contact ComicTrac technical support, and gives 
well deserved kudos to all those who helped make ComicTrac a reality.

Technical Support
CompuServe:
102125,3551

Internet:
heemeryp@cuug.ab.ca

Mail
Paul Heemeryck
StormWarden Enterprises
#232-10120 Brookpark Blvd S.W.
Calgary AB Canada
T2W 3G3

Technical Information:
Each 1000 comics takes approximately 1 meg of harddrive space. Use the Backup 

feature to backup and compress the database once you have entered many comics.

Credits
ComicTrac Written By: Paul Heemeryck at StormWarden Enterprises
Online Help Written By: Paul Heemeryck at StormWarden Enterprises
ComicTrac Guy Design: Tim Huesken
ComicTrac Logo Design: Jason Armstrong at Bullseye Software Development
Technical Consultant: George Tomic at Hurricane Software Solutions
Business Consultant: Sean McKeag at Another Dimension Comics.



ComicTrac Tips and Tricks
This section provides tips and tricks to get the most out of ComicTrac. If you find any tips 
which are not listed below, please send them to one of the addresses mentioned in the 
Technical Support section, and we will include them in the next release.

Context Sensitive Help
Always check the context sensitive help for the answer to your problems. Pressing 

the F1 key on any field will bring up short, hopefully helpful help. This was designed to 
provide the quickest answer.

The popup of the help appears where you position your mousepointer, not where the 
field is placed on the window. Use this to popup the help "away" from the field, so the field is
still visible.

Entering Comics
You can quickly enter comics using only the following information: Publisher, 

Series, Comic#, Condition, Value, Print# and Copies. All other information is optional 
and takes time to enter. However, the more information you enter for each comic, the more 
valuable the ComicTrac database is to you.

The Comments section of the comic can be extremely useful. You can use this area to
enter cross over information. For example, if you preface every comment about crossovers 
with an abbreviation such as "x-over", then you can search for all crossovers in your 
collection.

When you enter a new series name, be sure to include the date the series was 
originally published. This helps to distinguish series with the same names. This information 
is readily available from any of the major comic price guides.

Use the Group Add function whenever possible. If you have 300 to 390 of a comic 
series, and all information is the same, use the group add to add all 90 at once. You may 
have to go back and edit a few comics to get everything entered correctly, but it is a big 
time saver.

Printing Reports
The custom ComicTrac reports give you great information. However, once you have a 

significant amount of comics in the database (10,000 and up), it can take awhile to put all of 
the information together. Whereever possible, limit the amount of information you want to 
retrieve, simply for speed purposes. For example, if you want to print of a Need and Replace 
list for all of your comics, you should try doing it a series at a time for best speed response.

Tell Your Friends
This product like any software product relies on sales to keep it alive. If you find the 

product useful, please tell a fellow comic collector. StormWarden Enterprises already has 
planned several enhancements to the next version, but without enough interest in this 
program, it will never happen.



Changes Pending
ComicTrac wants to update the Comic Information window, but you have not saved a comic 
you were adding. If you do not choose to save the comic, all new information will be lost.



Changes Pending
ComicTrac wants to update the Comic Information window, but you have not saved the 
changes for a comic you were editing. If you do not choose to save the comic, all new 
information will be lost.



Changes Pending
You either are closing the Comic Information window or exiting the program, and have not 
saved a comic you were adding. If you do not choose to save the comic, all new information
will be lost.



Changes Pending
You either are closing the Comic Information window or exiting the program, and have not 
saved a comic you were changing. If you do not choose to save the comic, all new 
information will be lost.



Database Empty
ComicTrac cannot find any comics because the database is empty. All you can do is add 
comics. To add a comic, you must be on the Comic Information window.



No Match
There are no comics in the database which match the information you entered on the 
ComicTrac Find window. Re-enter your information on the Find window and try again. If you 
leave the Find window blank, all comics are retreived.



Cannot Close Summary
The Summary window and Comic Information window are closely linked. You cannot close 
the Summary window while the Comic Information window is open. Close the Comic 
Information window first and the close the Summary window.



Comic Already Exists
One of the comics ComicTrac tried to add during the Group Add procedure was already in 
your database. You can overwrite the existing comic with the new one, skip over this comic,
or cancel the Group Add.



Group Add Error
There was an error during the Group Add, and ComicTrac had to abort. Ensure you entered 
all information properly on the Comic Information window before you started the Group 
Add.



Limit Reached
In this version of ComicTrac you can enter only a limited number of comics. The registered 
and commercial version allow you to add unlimited numbers of comics.



Empty Database
You have not entered any comics, so ComicTrac cannot do any of the reports. Enter some 
comics and then try the reporting features again.



No Need or Replace
ComicTrac did not find any comics you needed or needed to replace. Remember, ComicTrac
only finds gaps in your collection, it does not detect whether you need the first 300 or the 
last 50.



Cannot Find Font
ComicTrac uses the Windows standard "MS Sans Serife" font for the report window display. 
If it cannot find this font, the report aborts. You should then re-install this font from your 
Windows disks.



Cannot Find Font
ComicTrac uses the Windows Standard "Arial" font for printing off the reports. If ComicTrac 
cannot find this font, it aborts. You should then re-install the font from your Windows disks.



Invalid Data
You either entered letters in a number only field, or the Date Published field is invalid. 
Change the field and try saving again.



Comic Already Exists
This comic already exists in the database. Each comic must have a unique Publisher, 
Series and Comic#.



Need Valid Information
You must enter valid information for the Publisher, Series and Comic# before ComicTrac 
can save the comic.



Need Valid Information
You must enter valid information in each column for a specific row. You need valid 
Condition, Print#, Value, and Copies information before the row is valid.



Need One Row of Information
You must fill in at least one row of the Comic Information Table before ComicTrac can save 
your comic.



New Publisher and Series
You entered a Publisher in the Publisher field which is not in the database. ComicTrac will 
create a new Publisher and consequently a new series based on the information.



New Series
You entered a Series    in the Series field which is not in the database. ComicTrac will start a 
new Series and the comic you enter will be under that series. Always check to make sure 
that you have not made a typing mistake and you really do want to add a new series.



Comic Successfully Saved
You successfully added a comic to ComicTrac.



Comic Successfully Saved
The changes you made to the comic were saved successfully.



Backing up the Database
ComicTrac is about to backup the database. If you continue, ComicTrac creates a backup of 
your database called "comtrac.bak" in your application directory. At the same time it 
compresses the database to save diskspace. You should backup the database at least after 
every 100 comics.



Database In Use
The ComicTrac database is open. You cannot backup or repair the database when it is open.
Close all windows and try again.



Corrupt Database
The ComicTrac database has become corrupted. ComicTrac automatically tries to repair the 
database. If the repair fails, copy a hopefully recent version of "comtrac.bak" to 
"comtrac.mdb". This could result in some data loss.



Unknown Error
Your guess is as good as ours! If you get this error message, please write down the 
information in the "Description" part of the error message window, as well as the version of 
ComicTrac you are using, and the steps you went through to create the error. Then send 
this information to one of the places listed on the About window and in the Technical 
support section of the help file.



Deleting Comic
You are about to delete a comic from the ComicTrac database. Once you delete the comic, 
it is gone for good.



Incorrect Registration
The information you entered was not valid registration information. Check to ensure the 
registration information you entered is exactly the same as the information you received 
when you registered.



Warranty
Disclaimer of Warranty

THIS PACKAGE (CONSISTING OF THE COMICTRAC SOFTWARE AND ASSOCIATED FILES AND 
DOCUMENTATION IS PROVIDED    "AS IS" WITHOUT REPRESENTATION OR WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
REPRESENTATIONS OR ENDORSEMENTS REGARDING THE USE OF, THE RESULTS OF, OR 
PERFORMANCE OF ITS APPROPRIATENESS, ACCURACY, RELIABILITY, OR CURRENTNESS.    
THE ENTIRE RISK AS TO THE USE OF THIS PACKAGE IS ASSUMED BY THE USER. IN NO 
EVENT WILL STORMWARDEN ENTERPRISES OR ITS SUPPLIERS BE LIABLE FOR ANY 
DAMAGES, DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL, RESULTING FROM ANY 
DEFECT IN THE PACKAGE, EVEN IF STORMWARDEN ENTERPRISES. OR    ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    ANY AND ALL USE OF THIS 
PACKAGE, FOR ANY PURPOSE, WITH NO REGARD TO THE LEGALITY OF SUCH USE OR 
PURPOSE, IS THE COMPLETE AND SOLE 
RESPONSIBILITY OF THE USER. 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO 
PERFORMANCE OR MERCHANT ABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED 
OR IMPLIED.




